EXPERIMENT 1A: Is it Heat or Work? MEMC (CH125)

Computational Lab Instructions

Purpose and Motivation

In this week’s lab, you will find an Excel tutorial /refresher and a set of exercises about the flow of
energy as heat and/or work. These will prepare you for Experiment 1B, where you will do some
hands-on measurements regarding the flow of heat and work.

You need to bring your laptop to lab each week, with Excel or another spreadsheet program
installed. You also need to bring a printed copy of the lab instructions with you to lab each week
(starting with these instructions). You are required to do Introduction to Excel before you come to
class.

Pre-Lab Assignment
I. Introduction to Excel

Excel is a spreadsheet program designed to make working with data easier. If you are an Excel
expert, feel free to skip the tutorial and directly build the spreadsheet in Figure 2 (using formulas)
and prepare the plot on page 5. Save ALL of your spreadsheet work; you may need to reference it
during next week’s lab.

Entering data and building formulas are described here to help you set up your calculations. Even
if you are somewhat familiar with Excel, you should complete this brief tutorial to serve your
immediate needs. If you work through the introduction and feel there is more you would like to
learn and do with Excel, there are excellent online tutorials available to youw including the

following:
1. Excel Tutorials, Florida Gulf Coast University. http://www.fgcu.edu/support/office2007 /Excel/index.asp
2. Excel Tutorials for Beginners from Goodwill Community Foundation. http://www.gcflearnfree.org/excel2007
3. Excel Shortcuts. https://support.office.com/en-us/article/Excel-shortcut-and-function-keys-1798d9d5-842a-
42b8-9¢99-9b7213f0040f

You will find many opportunities to use spreadsheet programs during your time here at Mines and
the rest of your science and engineering careers.

To begin, open Excel. You will see a Workbook and a toolbar. If your setup doesn't look exactly
like the one below, don't worry. All you need is the workbook and the toolbar across the top.
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Figure 1

The workbook is divided into cells, boxes designed to hold one data entry each. Each cell can be
referred to by a letter-number address; note the letters across the columns and the numbers down
the rows. For example, A1 is the address of the cell in column A row 1. You can tell what cell you're
in by looking at the upper left box on the toolbar. The current cell is A1 in the picture above.

Entering Data

(a) Entering Data into a cell is easy: select the cell you want with the mouse and type in your first
data entry (anything you wish).

(b) When you have finished with the cell press enter, tab, or return.

(c) Notice that your typing is echoed above the spreadsheet in a text field to the right. Edit the
contents of a cell by selecting the cell and then changing the entry either in the cell or in this
text field.

(d) Problems using spreadsheets usually have many data points arranged in a table. Enter a table
of data points (make up some values): select the starting cell and enter the data, pressing tab to
move across a row, or return to move down a column. The arrow keys will move the cursor to
adjacent cells in any direction as well.

(e) There are several built in data formats used by Excel; you may choose the most appropriate
from the Cells... command in the Format menu. Try changing the cell data format.

(f) You may also change the font size, type, or style for any cell, highlighting first and then using
the buttons on the toolbar.

Building Formulas

Start by constructing the spreadsheet below, which computes the velocity and height of an object
as a function of time falling from some initial elevation. We will set the spreadsheet up in three
columns: time, velocity, and height. In addition, we will need to define several parameters: the
mass of the object, its initial height, and the acceleration of gravity (next page):
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You will note that the parameters have been entered in cells B1, B2, and D1 with the cell to the left
of these entries simply providing information as to what is contained in the cell.

(a) Using the cell formatting features you've already learned, reproduce the top two rows (the
parameter portion) of the spreadsheet.

(b) Next we want to construct our columns. Give your columns appropriate names (Time, Velocity,
and Height) as in row 4 above. It is also advisable to specify the units for the data.

(c) Now let’s do the time column. Just enter a “0” in the cell under the heading and hit return, or a
down arrow. The active cell will advance to the next cell down, where you may enter a “1” etc.
Complete the column with at least 11 sec. Shortcut: Enter the 0 and 1 values, select (highlight)
BOTH of those cells, then carefully click and drag from the lower right hand corner of the “1” cell.
This is called “filling” the rows below, which can be done anytime the preceeding data follows an
obvious trend.

For the velocity and the height, we want Excel to compute the values from a formula. We know (or
can look up) that the velocity of a falling object (ignoring air resistance) at a time ¢ is given by v=g*
t, where g is the acceleration of gravity (approximately 9.8 m/sec? near the Earth’s surface). Enter
this formula in the column under velocity. Entering a formula is straightforward once you
understand the difference between relative and absolute addresses.



(d) To illustrate, enter the formula for velocity in cell B6. The acceleration of gravity is in cell B1
and the time we are interested in is in cell A6, so in B6 enter:

=B1* A6

The initial equal sign tells Excel that this is a formula, and that it will execute the instruction
that follows, i.e., multiply the contents of cell B1 by the contents of cell A6. Also note that we
used * to indicate multiplication. Similarly /, +, and * are used for division, addition, and
exponentiation, respectively. Enter this formula, hit return, and voila, the value “0” (9.8 * 0)
appears in cell B6.

(e) Another way to enter cell addresses in a formula is to click in the cell of interest rather than
typing in its address. To do the same calculation in B6 again, try:

= (click in B1) * (click in A6) (return)
You should see the same result.
(f) Now, we could enter the next formula in B7 as:
=B1*A7

But that seems like a bit of a drag, having to type essentially the same formula in every cell. So
try the following shortcut: Click on cell B6 and then copy it (either by using the menu or the
key pad—on a Mac “command C”). Now highlight B7 and paste (on a Mac “command v”).

What you get is the number 500, which is clearly wrong. To figure out what happened, highlight
B7 and look in the text field above the columns. What you pasted into the cell was the formula:

=B2* A7

What Excel did was paste in the addresses of cells that had the same relative positions to the ones
in the initial formula. In the case of the time variable, that is exactly what we wanted (calculate for
each increment of time), but in the case of g (the acceleration of gravity) that will not work - we
want it to be constant, so we need Excel to always go to cell B1 for the acceleration of gravity. That
is, we need it to reference this cell by its absolute address.

Absolute addresses are specified with a leading “$” so the address of cell B1, in absolute terms, is
$B$1. (For the curious: What do $B1 and B$1 specify?)

(g) Return to cell B6 and replace the formula there with:
= $B$1 * A6

Hit return and once again a “0” will appear in Bé.



(h) Now highlight B6 and copy it. Then highlight the whole set of cells from B7 to B17 and paste.
You should see your numbers are the same as in the example above. Go through the cells B7 to
B17 and look in the text field to discover the formulas that were placed in these cells following
the paste.

Careful: Any time you click on a formula within a cell, any typing or clicking you do will edit your
formula! To leave the formula cell without editing it, you need to hit the Escape or Return key.

(i) Now fill in the height column. The distance fallen in time ¢t is given by the formula g*t?/2, so
the height at time t is simply the initial height minus the distance fallen: h; - g*t2/2.

Visualizing Data

We now want to graph (visualize) some of the information from the spreadsheet. If your version

of Excel varies from the instructions below, experiment or ask instructors/classmates for help.

1.
2.

Begin by highlighting an empty cell far from your data (3-4 cells away).

Click the “Insert” tab, click the arrow under “Scatter” then choose “Scatter with smooth lines”.
This will give you an empty plot and the tool bar should automatically change to the “Chart
Tools”.

Click on the “Select Data” button in the tool bar, this will open a pop-up window. In the pop-up
window click “Add”. This will pop-up the data entry window.

The first input is the name of the curve. Leave this blank unless you have more than one curve on
a single plot. For this exercise, you will leave it blank.

Because you want the plot to be height versus time (meaning Y is height and X is time), you
want to enter in the time data points in the “Series X Values” field. To do this, click in the field.
Then click the first time-point, hold down “Shift”, then click the last time-point in the spread
sheet.

Repeat step 5 for the “Series Y Values”, but use the height data points instead of the time data
points. NOTE: you must clear out the ={1} from the field before you click on the cells
containing the data points.

Click “Ok” (once or twice) and now you should have a plot similar to the one below.
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There is “short-cut” method to do this — by highlighting the data you wish you use for the chart, and
then clicking on the chart type you want. However, your data may not always be in the correct
format to display this properly, so learning the long way (above) will be beneficial to you in the
future.



The above plot is not very presentable, so now we will fix it up to make it look more professional.

8. First click on the legend (“Series 1) and then hit “Back Space” or “Delete” to delete the legend.

9. Double click on the vertical (Y) axis to open the axis formatting window. The last three options
are for where the horizontal axis crosses the vertical axis. The Excel default is at 0.0, but for this
plot it puts it too high on the plot, to fix this click the button for axis value and enter in the
minimum Y-axis value (in this case it is -200.0).

10. Click the horizontal cross hairs to highlight them, as shown below. Then, hit “Back Space” or
“Delete” to delete them.
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11. Now to add labels to the chart and the axes click the “Layout” tab under the “Chart Tools” tab.

12. Click on the arrow below “Chart Title” and choose the “Centered Overlay Title”, highlight the
default text and enter in your chart title. For this exercise type in “Height vs. Time, Freely
Falling Object”.

13. Then to add axis labels click the arrow below “Axis Title”, hover the mouse over “Primary
Horizontal Axis”, then click on “Title Below Axis”. Highlight the default text and type in the
label for that axis. For this exercise use “Time (s)”.

14. For the vertical axis label repeat step 13, but hover the mouse over “Primary Vertical Axis” and
Click “Rotated Title” and type in “Height (m)”.

15. You should now have a presentable plot similar to the one shown below
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@ STOP HERE. You must show your TA the above graph to get credit for doing the Pre-Lab
assignment. You will begin Part 2 Exercises in lab.



I1. Exercises

Now you’re ready to answer some questions about energy conservation!
e Each lab partner should answer all numbered QUESTIONS in their own lab notebook; you
will turn in your carbon copy pages when you arrive in lab next week.
e Remember to save all of your spreadsheet work! You may need it next week during lab.

1. Add three more columns to the spreadsheet you have prepared: Potential Energy, Kinetic
Energy, and Total Energy. Fill in the columns by computing these values.

The potential energy at time t is given by the product of three terms—m g h—where m is the
mass of the object, again g is the acceleration of gravity, and h¢ is the height at time t. The
kinetic energy at time t is given by the formula—1/2 m v#—where v# is the square of the
velocity at time ¢t. Finally, the total energy is the sum of the potential and kinetic energy.

QUESTION 1: What key observations do you note about the Total Energy of the falling
object?

2. Construct plots of height (x-axis) versus: Potential Energy, Kinetic Energy, and Total Energy (y-
axis). Hint: it helps to make one plot instead of three separate plots.

Take a look - some of this data is quite obviously redundant. If you know the total energy at
any time, and the potential energy as a function of height, all the other curves may be
determined from this information alone.

QUESTION 2: Let’s think of this as a solid object falling toward solid ground. You live in
a very rigid world where gravity pulls objects to the ground but the object does not
bounce back or deform. Now answer the following questions:

(a) Let’s call height = 0 the “ground level”. How does the velocity of the falling object
change as it approaches the ground? Do not comment yet about when it is ON the
ground, but just up to that point.

(b) For our real object-air-ground system, negative height values obviously aren’t
possible (we are assuming very solid ground). What is the velocity of this real object at
exactly height = 0?7

(c) How does the potential energy, kinetic energy and total energy of the system change
just before and just after the object actually hits the ground? Explain.

(d) Isaac Newton - one of the greatest physicists of all time - did not recognize that
total energy is conserved in any process when he was developing the equations above.
It was over 100 years before that was recognized by Count Rumford and associates.
Considering your answer to part (c) above, speculate on why...

QUESTION 3: USING INITIAL HEIGHT OF FALLING OBJECT



(a) This time we take the same solid object falling toward solid ground, but change the
reference point (H; = 0) to be in the initial height of the object. How does the velocity of
the falling object change as it approaches the ground from this initial height?

(b) What is the velocity of this real object at exactly ground level?

(c) How does the potential energy, kinetic energy and total energy of the system change
just before and just after the object actually hits the ground? Explain.

(d) How does our choice for measuring height of the falling object change the total
energy?

@ STOP HERE. You may finish the rest of the questions in lab or take home for homework. .

III. Homework

e The rest of questions 4-6 can be done as homework. You will turn in all questions (1-6)
answered on notebook pages at the beginning of next lab period. If you are stuck on any
questions/graphs 1 encourage you to visit office hours, because this will aid in your
understanding of next week’s lab.

Look again at your plot of potential energy. A curve that specifies the potential energy as a
function of position is called a potential energy surface. Knowledge of the shape of this surface,
and the value of the total energy at any single position, is sufficient to predict the future and past
behavior of a particle said to be moving on this surface. Much of what we will be doing this
semester reduces to understanding the shape of a potential energy surface.

4. Animportant potential energy surface is that of an electron moving around a proton. The
Coulomb potential gives the interaction energy between two charged particles and is:

9192
T2

V=k

where Vis a common notation for potential energy, k is a positive constant, g1 and g2 are the
charges on particles 1 and 2, and r12 is the distance between them.

QUESTION 4: Explain what happens to the potential energy between two oppositely
charged particles as they get closer together. Is this consistent with your expectations?

In ST units, the potential energy (Joules) between one electron and one proton separated by a
distance r (in meters) is given by:
_ —2.30708x10°28

r



5. Use Excel to plot the potential energy surface for separations between 10-1* and 10-1© m (10-10
m is a unit called an Angstrom, A). To make your graph legible (in the correct range), you will
need to use a bit of ingenuity...

Consider this (just to think about - does not need to be written down)...
Does the information conveyed in this plot match your prediction in Question 27?

Let us assume that the electron proton system was prepared by releasing a stationary electron
at a very large distance from the proton, essentially where r is infinity.

QUESTION 5: (a) When r is infinity, what is the potential energy of this system?
(b) What is the kinetic energy of a stationary electron?
(c) What is the total energy of this system for all values of r?

(d) In grammatically correct English sentences, explain (in your own words)
how the answers to this question demonstrate the 15t Law of Thermodynamics.

6. For afinal observation about this system, use Excel to plot the velocity of this electron between

10-1Tand 101 m (1 to 10 A)from a proton. You will need the mass of an electron in SI units:
me = 9.109383 x 10-31 kg.

QUESTION 6: How does the velocity of the electron change as it moves toward the proton?

QUESTION 7: For this problem we will be working in 2-D. Let’s assume that somehow we
confine a proton at the point (-1, 0} and another proton at the point (1, 0). To this system of
constrained positive charges, we add an electron that is free to move in the xy plane. See
figure.

(x,y)
H— 2Ox
(-1,0) (1,0)

(a) Write an equation giving the potential of the electron as a function of its x, y position.
(b) Attempt to draw this function.

(c) Briefly discuss what the potential function would look like for one electron moving
among many fixed protons. How about many interacting electrons moving among many
fixed protons?



